VS2DI—A Graphical Software Package for Simulating Fluid Flow and Solute or Energy Transport in Variably Saturated Porous Media

U.S. GEOLOGICAL SURVEY

Water-Resources Investigations Report 99-4130
VS2DI—A Graphical Software Package for Simulating Fluid Flow and Solute or Energy Transport in Variably Saturated Porous Media

By Paul A. Hsieh, William Wingle, and Richard W. Healy
CONTENTS

Abstract ................................................................................................................................................................. 1
Introduction .......................................................................................................................................................... 1
Preprocessor ......................................................................................................................................................... 3
  Pull-down menus ........................................................................................................................................... 4
  Entering Spatial Data ................................................................................................................................. 6
Postprocessor ................................................................................................................................................... 10
  Files ............................................................................................................................................................ 12
    Document Files .......................................................................................................................................... 13
    Model Input Files ...................................................................................................................................... 14
    Model Output Files .................................................................................................................................. 14
    Saved Simulation Files ............................................................................................................................ 14
How to obtain and install VS2DI ....................................................................................................................... 15
References cited ................................................................................................................................................. 15

FIGURES

  1. Main window of VS2DTI preprocessor ........................................................................................................ 3
  2. Textural Class window of VS2DTI ................................................................................................................ 7
  3. Postprocessor window of VS2DTI .................................................................................................................. 11
  4. Relations between files and the preprocessor, postprocessor, and numerical model ................................... 13
VS2DI—A Graphical Software Package for Simulating Fluid Flow and Solute or Energy Transport in Variably Saturated Porous Media

By Paul A. Hsieh, William L. Wingle, and Richard W. Healy

ABSTRACT

VS2DI is a graphical software package for simulating flow and transport in variably saturated porous media in one or two dimensions using cartesian or radial coordinate systems. This software package consists of three components: (i) VS2DTI, for simulating fluid flow and solute transport, (ii) VS2DHI, for simulating fluid flow and energy (heat) transport, and (iii) VS2POST, a standalone postprocessor, for viewing results saved from previous simulation runs. Both VS2DTI and VS2DHI combine a graphical user interface with a numerical model to create an integrated, window-based modeling environment. Users can easily specify or change the model domain, hydraulic and transport properties, initial and boundary conditions, grid spacing, and other model parameters. Simulation results can be displayed as contours of pressure head, moisture content, saturation, concentration or temperature, and velocity or flux for each time step, thus creating a simple animation. The numerical models used for flow and transport calculations are the U.S. Geological Survey’s computer models VS2DT (for solute transport) and VS2DH (for energy transport). Although these models are integrated into the software package, their source codes are maintained as individual Fortran programs that can be compiled and run separately from the graphical user interface. This report provides an overview of the features and capabilities of the VS2DI software package. Detailed instructions on how to use the software are provided by on-line help manuals and tutorials that are included in the software.

INTRODUCTION

VS2DI is a graphical software package for modeling flow and transport in variably saturated porous media. This package consists of three components: (i) VS2DTI, for simulating fluid flow and solute transport, (ii) VS2DHI, for simulating fluid flow and energy (heat) transport, and (iii) VS2POST, a standalone postprocessor, for viewing results saved from previous simulation runs. Both VS2DTI and VS2DHI combine a graphical user interface with a numerical model to create an integrated, window-based modeling environment. The names VS2DTI and VS2DHI are derived by appending the letter "I" (for "Interactive") to the corresponding numerical models used for flow and transport calculations.

The graphical user interface consists of a preprocessor and a postprocessor. The preprocessor is used to define the model domain, hydraulic and transport properties, initial and boundary conditions, grid spacing, and other model parameters. Data that vary spatially are entered and edited graphically with "drawing" tools that are commonly found in other graphical software. Data that are independent of space are entered into tables. Model options are selected from pull-down menus and various buttons, check boxes, and text fields. Once all required data have been entered, the postprocessor may be invoked to run the simulation. As the postprocessor is being launched, model input files are automatically generated and loaded to the numerical model. The postprocessor is linked with the numerical model in such a way that as the model
runs, simulation results are displayed for each time step, thus creating a simple animation. Simulation results can be displayed as contours of pressure head, moisture content, saturation, concentration (for solute transport) or temperature (for energy transport), velocity or flux. In addition to the graphical displays, ASCII (or text) output files are also generated. These files may be viewed in a text editor, printed, or imported to graphing programs.

The numerical models used for flow and transport calculations are the U.S. Geological Survey’s computer models VS2DT (Healy, 1990; Lappala and others, 1987) and VS2DH (Healy and Ronan, 1996). VS2DT is a finite-difference model that solves Richard’s equation for fluid flow, and the advection-dispersion equation for solute transport. The model can analyze problems in one or two dimensions using either cartesian or radial coordinate systems. Relations between pressure head, moisture content, and relative hydraulic conductivity may be represented by functions developed by van Genuchten (1980), Brooks and Corey (1964), Haverkamp and others (1977), or by data points. Initial hydraulic condition can be specified as static equilibrium, specified pressure head, or specified moisture content. Boundary conditions include specified pressure or total head, specified flux, infiltration with ponding, evaporation, plant transpiration, and seepage faces. Solute transport processes include advection, dispersion, first-order decay, adsorption, and ion exchange. VS2DT has been applied in a variety of field studies (for example, McCord and others, 1997; and Haldaford, 1997). VS2DH is a version of VS2DT that has been modified to simulate energy transport instead of solute transport. An example application of VS2DH can be found in Bartolino and Niswonger (1999). Both VS2DT and VS2DH are written in Fortran 77. Although these models are integrated into the graphical software package, their source codes are maintained as individual Fortran programs that can be compiled and run separately from the graphical user interface.

The VS2DI software package was developed using a combination of Java, C, and Fortran programming languages. This software has run successfully on the following operating systems: Microsoft Windows 95, 98, and NT 4.0, Silicon Graphics Irix 6.3, 6.4, and 6.5, and Sun Solaris 2.6. For other computer platforms, the usability of VS2DI depends on the availability of a Java Development Kit for that platform, and the ability to compile Fortran and C programs into dynamic or shared libraries that can be used by the Java program. Additional information on computer requirements can be found in the "readme" file distributed with the software.

This report provides an overview of the features and capabilities of the VS2DI software package. The descriptions of the preprocessor and the postprocessor apply equally to VS2DTI and VS2DHI. Detailed information on how to set up and run a simulation can be found in the on-line help manuals contained in the software. An effective way to learn how to use the software is by following the tutorials. In addition to understanding the procedure for using this software, users should also understand the assumptions, approximations, and limitations inherent in a numerical model. Therefore, users are strongly urged to obtain copies of the reports that document the numerical models VS2DT (Healy, 1990; Lappala and others, 1987) and VS2DH (Healy and Ronan, 1996). Details on obtaining these reports are given in a subsequent section.

VS2DI is a public-domain software with the following exception. This software uses the program triangle.c version 1.3, written and copyrighted by Jonathan Richard Shewchuk, Computer Science Division, University of California, Berkeley. Triangle.c is freely available on the World Wide Web at: http://www.cs.cmu.edu/~quake/triangle.html. The author of triangle.c has granted free distribution of that program for noncommercial use. Distribution of triangle.c as part of a commercial system is permissible only by direct arrangement with the author of that program.
The preprocessor consists of a main window with a drawing area for entering graphical data (fig. 1). In addition, numerical data can be entered into tables, and options can be selected via menus. Once all required data have been entered, the postprocessor may be invoked to run the simulation.

Figure 1. -- Main window of VS2DTI preprocessor.

The "Drawing Area" is where spatial data are viewed. The "Active Data" selector is used to switch among different types of spatial data to be entered or edited on the drawing area. Spatial data include the model domain, textural map, initial and boundary conditions, observation points, grid, and site map. The toolbar contains buttons for data entry and editing. Menus are used for file management, displaying and editing data, selecting options, and accessing the help manual. Horizontal and vertical rulers show the coordinate axes system. The cursor coordinates are displayed in the lower left corner of the window and give the position of the cursor with respect to the model origin. These features are explained more fully in the following sections.
Pull-Down Menus

Five pull-down menus are located at the top of the main window: "File", "Edit", "Options", "Show", and "Help" (fig. 1).

File

The "File" pull-down menu allows the selection of a new ("New") or existing ("Open") document file, which stores the data entered into the preprocessor. It also allows the document file to be saved ("Save") or renamed ("Save As"). Note that document files are not the same as model input files, which are read by the numerical model. In most cases, users may ignore the model input files because they are automatically generated and read by the numerical model. (This occurs when the postprocessor is invoked.) However, the "Export data" menu item may be used to generate model input files for special purposes. (See additional discussions in the section on "Files"). The "Print" menu item allows printing whatever is currently displayed in the Drawing Area. Selection of the "Export bitmap" menu item allows the user to save a bitmap file of whatever is displayed in the "Drawing Area". The "Exit" item in the menu terminates the program.

Edit

The "Edit" pull-down menu allows selection of several common editing commands, such as "Undo", "Redo", and "Delete". The actual items that appear in this menu depend on how the "Active Data" is set and are discussed in the subsequent section on Spatial Data Types.

Options

The "Options" pull-down menu has two items: "Drawing..." and "Model...". Selection of "Drawing..." opens the Drawing Options dialog box which is used to set the size and scales of the drawing area as well as the location of the origin and ruler units. Selection of the "Model..." item opens the Model Options dialog box. This box contains five or seven, if transport is simulated, tabbed panels within which the user selects and sets various options.

The Basic panel allows selection of length, time, and mass or energy units. It is recommended that the user set these units as the first step in constructing a simulation and that they never be changed. Any set of units can be used, but consistency must be maintained in using those units when entering values for hydraulic and transport properties (such as hydraulic conductivity) and boundary conditions. If units are changed after data have been entered, then the user must reenter the affected data. This software does not automatically convert data to different units. The Basic panel also allows selection of radial coordinates (as opposed to cartesian coordinates) and simulation of solute or energy transport, evaporation, and plant transpiration.

The Flow panel allows three options for setting initial conditions for the flow equation: 1) Equilibrium profile - the initial pressure head equals negative elevation head above a water table, 2) Pressure head - as input by the user, and 3) Moisture content - as input by the user. (Selection of actual values for initial conditions is discussed in the section on Initial Hydraulic Conditions under Entering Spatial Data.) In this panel the user can also select the method for calculating intercell relative hydraulic conductivity. Arithmetic mean is the preferred method, but
users may also select geometric mean or upstream weighting. Four methods are allowed for representing the hydraulic characteristic function: the van Genuchten model, the Haverkamp model, the Brooks-Corey model, and tabular data. Details on these methods are given in Lappala and others (1987) and in the on-line help manual.

The Transport panel appears only if the Simulate transport option was selected on the Basic panel. On this panel there are two options each for space and time differencing. Centered in space differencing is preferred; backward in space is less accurate, but can be used to avoid oscillations when coarse spacing is used. Centered in time differencing (Crank-Nicholson scheme) is more accurate than backward in time (fully implicit scheme) but can cause oscillations. When solute transport is simulated, there are several options in VS2DTI for adsorption and ion exchange. Users may select one and only one of these options. Details on the available adsorption isotherms and ion exchange reactions as well as definitions for the required parameters are contained in Healy (1990) and in the on-line help manual.

The Solver Panel allows entry of values for parameters that affect the iterative matrix solver used by the numerical model. The Relaxation parameter should generally be in the range of 0.4 to 1.2. The Minimum and Maximum number of iterations control the range in number of iterations that the solver will attempt. If convergence is not achieved in the allowed number, then the solution is restarted for the time step with a reduced time-step size. If convergence is not achieved after three consecutive time-step reductions, the simulation is considered to have reached convergence failure. When this occurs, the consequence depends on whether or not the user selected the option to Stop simulation at convergence failure. If so, then the simulation is terminated. If not, then the simulation proceeds to the next time step after printing a warning. It is recommended that the Stop simulation at convergence failure option be selected. The simulation will also halt if the Maximum number of time steps is reached. Closure criteria for head and concentration are used by the iterative matrix solver to test for convergence. If the maximum change in head or concentration (or temperature) for all nodes between successive iterations is less than the criterion, then convergence is assumed. In general, as these criteria are decreased, the accuracy of results is improved and the computational effort is increased.

The Output panel controls the writing of model output files. Specific information on these files is contained in the "Files" section of this report. There are five Output Variables that may be selected. If selected, then values for these variables at every node will be printed to the main output file at selected Output Times. (Note that if the Print Result option of the Recharge Period window is selected, these values will be printed for every time step in the recharge period.) Mass Balance Output may be printed to the main output file at selected Output Times or after every time step. Output Times can be selected to coincide with regular time intervals or they can be set by the user.

The Fluid Balance panel allows selection of any combination of fluid balance components to be written to the auxiliary output file, "file09.out". For each selected component, three entries are written: total for simulation, total for time step, and rate for time step.

The Solute or Energy Balance panel appears only when the Simulate transport option is selected on the Basic panel. It allows selection of solute or energy mass balance components in exactly the same manner as described for the Fluid Balance panel.
Show

The "Show" pull-down menu allows the user to select spatial data to display in the Drawing Area. One or more of these data types can be displayed at a time. The user may also select display of the "Postprocessor" and three windows that specify attributes of the spatial data: the Textural Class window, the Evapotranspiration window, and the Recharge window. The Textural Class window is linked to the Textural Map spatial data type and is discussed in that section. Similarly, the Recharge Period window is linked to the Boundary Conditions spatial data type and is discussed in that section. The Evapotranspiration window is presented in the following paragraph. Selecting the "Postprocessor" opens the Postprocessor window, which is discussed in a later section.

The Evapotranspiration window contains a table of parameters for each evapotranspiration period. It can be displayed only if either or both of the Simulate evaporation or Simulate transpiration options are selected on the Basic Model Options panel. The columns of the table are divided into two tabbed panels - one for evaporation, the other for plant transpiration. The user may enter the evapotranspiration (ET) period length, add new ET periods, or edit parameters in existing ET periods.

Help

The "Help" pull-down menu has two items: "Contents..." and "About...". When "Contents..." is selected, an HTML browser window is opened to the table of contents of the online help manual. This manual contains extensive information on how to use the software. There are manual pages for all windows and spatial data types. The manual is organized so that the table of contents can be used to navigate to any desired page. The order in which material is presented in the table of contents is designed to guide new users through all steps of creating a new simulation. There is also a tutorial that new users will find useful before constructing their own simulations. The "About..." item displays the version number of this software.

Entering Spatial Data

Eight different types of spatial data are discussed in the following paragraphs. To enter or edit a particular data type, it must be selected as the "Active Data" in the main window (fig. 1).

Domain

The domain is the region in which fluid flow and transport are simulated. The domain is surrounded by the exterior boundary. Regions inside the domain may be excluded by interior boundaries. Exterior and interior boundaries are represented by polygons with an unlimited number of vertices. There are five buttons available in the toolbar. From top to bottom, these buttons are used for editing (or moving) polygons, creating an exterior boundary, creating an interior boundary, adding additional vertices to a polygon, and zooming out. Items available in the "Edit" pull-down menu are: "Undo", "Redo", "Select All", and "Delete".
**Textural Map**

The textural map shows the spatial distribution of textural class zones. Each zone represents a region in which flow and transport properties are assumed to be uniform. The properties for the textural classes are entered in the **Textural Class** window. Zones are represented by polygons that are drawn by the user. There are five buttons on the toolbar. From top to bottom, these buttons are used for selecting, moving, or reshaping a zone, adding a zone, adding a vertex to an existing zone, viewing a discretized version of the map (this button appears only after the grid has been defined), and zooming. Items under the "Edit" pull-down menu include "Undo", "Redo", "Select All", "Delete", "Bring to Front", and "Send to Back". These last two items are available because zones may overlap one another. When portions of the domain are covered by more than one textural class zone, the overlying (or topmost) class is used. Any portion of the domain that is not covered by a textural zone is assigned to the "inactive" textural class.

When the textural map is selected as the "Active Data", the **Textural Class** window is displayed (fig. 2). The window may also be displayed through the "Show" pull-down menu. The window contains the table of parameter values for each textural class. The table is divided into two tabbed panels, one for flow and one for transport, if transport is simulated. The parameters that appear in the table are dependent on the options that were selected by the user in the **Model Options** dialog box (such as which representation is used for the hydraulic characteristic function and whether adsorption is to be simulated). The parameters are defined in the on-line help files.

![Textural Class Window](image)

**Figure 2.** -- Textural Class window of VS2DTI.

Cells in the table are not directly editable. Instead, the buttons below the table may be used to add, edit, or delete a textural class. When the **Textural Class** window is opened for the first time, it will contain a single class named "inactive". This is the default class and represents regions of the domain that are impermeable (that is, water will not flow through zones that are assigned to this class). The parameters in this class are not editable. Before delineating a texture class zone on the "Drawing Area", the texture class must be added the table. To do so, the user must click the "Add" button. This will display the **Add Textural Class** dialog box. The user then selects a color for the new class and enters the required flow and transport parameters. Definitions
of all parameters are contained in Healy (1990) or Healy and Ronan (1996) and in the on-line help manual. If the van Genuchten functions were selected to represent the hydraulic characteristics, the user has the option of selecting hydraulic parameters from a catalog of values for generic soil types. References for these parameter values are contained in Lappala and others (1987) and Carsel and Parrish (1988). Zones for any texture class can be delineated on the "Drawing Area" by highlighting the row of the desired texture class and using drawing tools available on the toolbar. Parameter values for existing textural classes may be edited by highlighting the appropriate row and selecting the "Edit" button. This will open the Edit Textural Class dialog box and allow the user to change any values. Textural class data may be saved to or read from an external file by selecting the "Custom" button.

**Initial Hydraulic Condition**

Initial hydraulic conditions may be specified in terms of pressure head, moisture content, or an equilibrium profile. This selection is made in the Flow panel of the Model Options dialog box. Depending on the selection, the entry in the Active Data Selector may appear as "Initial Equilibrium Profile", "Initial Pressure Head", or "Initial Moisture Content". When initial conditions are specified in terms of pressure head or moisture content, the user may draw contour lines of equal value across the model domain. The buttons on the toolbar allow the user to select or edit contour lines, add closed or open contours, add a vertex to a contour line, display the discretized initial conditions, zoom in or out, and view labels on the contour lines. Options available in the "Edit" pull-down menu include: "Undo", "Redo", "Select All", "Delete", "Contour Value..." (to edit contour values), "Interpolation Method..." (for selecting an alternative interpolation method), and "Color Scale" (for modifying the color scale).

If an initial equilibrium profile is selected, pressure heads are set equal to the negative elevation head above a water table. The user must specify the $z$ coordinate of the water table. The user may also replace the upper part of the equilibrium profile by a constant Minimum pressure head. In a new simulation, the user sets these values after opening the Initial Equilibrium Profile dialog box when "Initial Equilibrium Profile" is the "Active Data". This is done by clicking on the top most button of the toolbar or through the "Edit" pull-down menu. The region from the water table downward (the saturated zone) is colored blue. A red line is drawn at the $z$ coordinate where the negative of elevation head above the water table equals the minimum pressure head. Pressure head below the red line is hydrostatic (uniform total head). Pressure head above the red line is equal to the minimum pressure head. The depth of the water table and the minimum pressure head may be modified by reopening the dialog box or by simply clicking and dragging the water table or red line.

**Initial Concentration or Temperature**

These data are displayed only if transport is being simulated. Initial values for concentration or temperature are entered with contour lines in the same manner described for initial pressure heads and moisture contents.
**Boundary Conditions**

Boundary conditions must be specified for each recharge period. A recharge period is a time span during which boundary conditions and stresses remain unchanged. For each recharge period, boundary conditions must be assigned to each segment of the exterior boundary plus any interior boundaries. A segment is the straight line connecting two adjacent vertices on a boundary. A boundary condition applies to the entire segment. To vary the boundary condition along a segment, it is necessary to insert vertices on the segment to subdivide it into smaller pieces. Different boundary conditions can then be specified on the subdivided pieces.

Before boundary conditions can be assigned, recharge periods must be created. This is accomplished with the **Recharge Period** window, which is automatically opened when "Boundary Condition" is the "Active Data". This window can also be opened from the "Show" pull-down menu. The window contains a table of recharge period parameters. Each row corresponds to a different recharge period. Columns contain parameter values. The values in the table are not directly editable. To add a new recharge period, the user must click on the row of the recharge period that the new period is to follow. Then the "Add" button should be selected at the bottom of the table. This will open the **Add Recharge Period** dialog box. The recharge period parameters can then be entered. Definitions and descriptions of these parameters are contained in Healy (1990) and in the on-line help manual. If the user wishes to modify parameter values, the recharge period row must be selected and the "Edit" button clicked. This will open the **Edit Recharge Period** dialog box.

Once recharge periods have been created, boundary conditions can be assigned. Both flow and transport boundary conditions must be specified. To specify boundary conditions, "Boundary Conditions" must be selected as the "Active Data". Next, the row of the recharge period of interest must be selected in the **Recharge Period** window. To assign boundary conditions, the user selects a boundary segment and clicks on it. Multiple boundary segments can be selected by holding the mouse button down and dragging the mouse across them. Selected segments will be highlighted in gray. Next, the user opens the **BC for Recharge Period** dialog box by clicking the "BC" button on the toolbar. In this box, the desired flow and transport boundary types may be selected. Users may also select the option to set this boundary condition for all subsequent recharge periods. Once a boundary condition is selected, it is colored according to the key displayed on the toolbar. Other buttons on the toolbar allow for display of labels of boundary condition values and zooming. Items available in the "Edit" pull-down menu include "Copy All To..." which allows the user to copy all boundary conditions from one recharge period to another period, and "Corner Policy..." which allows the user to determine how boundary conditions should be applied at the vertices where boundary segments are joined.

**Observation Points**

Observation points denote locations where simulated total head, pressure head, moisture content, saturation, and concentration or temperature are written to output file, "file11.out", at every time step. Observation points can be added when "Observation Points" is the "Active Data" by using the second button from the top of the toolbar. The user then simply clicks on the desired location for the observation point. Points can be moved by using the top most button. Items in the "Edit" pull-down menu include "Undo", "Redo", "Select All" and "Delete".
**Grid**

The grid consists of vertical and horizontal grid lines forming a rectangular array of cells. To lay out the grid, the user selects "Grid" as the "Active Data". The grid may be edited on the "Drawing Area," on the Grid window (which may be opened by the button on the toolbar), or through the "Edit" pull-down menu.

A uniform grid containing columns of equal widths and rows of equal heights can be created by selecting "Uniform Grid..." from the "Edit" pull-down menu. This opens the Uniform Grid dialog box, into which the user may enter values for the number of columns and rows. Clicking "OK" then causes the grid to be displayed. Buttons on the toolbar permit the user to move the entire grid, move individual grid lines, add new vertical or horizontal lines, show or hide the Grid window, display the "Drawing Area" as it will be discretized, and zoom in and out.

The Grid window can also be used to add additional vertical or horizontal grid lines. Additional items that can be selected from the "Edit" pull-down menu include "Subdivide..." for adding additional horizontal or vertical grid lines, "Select All..." for selecting all vertical or horizontal lines, and "Delete" for deleting grid lines.

**Site Map**

As an option, the user may load a site map in a "gif" or "jpg" graphics file. Such a map, although not editable, could be used to guide the drawing of graphical data. To load a map, the user must set "Site Map" as the "Active Data" and then select the fourth button from the top of the toolbar. This opens the Load Site Map dialog box, which allows the user to select the desired graphics file. The top most button on the toolbar can be used to move or resize the site map. The next button allows the user to stretch or compress the map in a manner that keeps one point fixed. This feature is useful for aligning the site map axes system with the rulers. Further details for resizing the site map are contained in the on-line help manual. The other buttons allow zooming and bringing the map to the front or sending it to the back.

**POSTPROCESSOR**

The postprocessor consists of a window to display simulation results, control the simulation, save simulation results on disk for later playback, and display fluid and solute or energy balances. The postprocessor initially starts up in "computational" mode. When the postprocessor is in computational mode, it is linked with the numerical model in such a way that as the model runs, the computed pressure head, moisture content, saturation, concentration or temperature, velocity, or flux are displayed for each time step, thus creating a simple animation of model results. The animation speed depends on the computation time needed for each time step. Simulation results can be saved to a file for later playback. At the end of the simulation, if results are saved, the postprocessor enters into "playback" mode. In playback mode, the postprocessor replays the simulation by reading the saved results from file, without the need for computations by the numerical model. Animation speed is typically faster in playback mode than in computational mode.
The Postprocessor may also be run in a standalone mode to: play back a saved simulation (this is the main intended use of the standalone postprocessor); run a simulation using data exported from the preprocessor, and possibly modified by the user in a text editor (this feature is intended for knowledgeable users); or run a simulation using data originally prepared for earlier versions of VS2DT or VS2DH (version 2.5 for VS2DT and version 1.0 for VS2DH; this feature is intended for knowledgeable users).

Figure 3 shows an example of the VS2DTI Postprocessor window during a simulation. Contours of concentration are displayed along with a color scale. Below the contour plot is information on simulation time and mass balance errors. The six buttons on the toolbar allow the user to run a simulation, halt a simulation, advance a simulation one time step, reset a simulation for playback (only available in playback mode), zoom in or out, and display velocity or flux vectors.
There are three pull-down menus at the top of the window: "Action", "Options", and "Help". Menu items under "Action" are "Terminate computation", "Restart computation", "Print", "Export bitmap", and "Done". If "Terminate computation" is selected, the simulation is terminated at the current time step. If simulation results are saved, the postprocessor enters into playback mode. If "Restart computation" is selected, the postprocessor enters into computational mode and the simulation is set to the initial state. The "Print" menu item allows printing the display in the postprocessor. The "Export bitmap" menu item allows the user to save a bitmap file of the display. Selecting "Done" closes the Postprocessor window.

Menu items under "Option" include "Drawing", "Color Scale...", "Vector", "Simulation", and "Buffered graphics". Selection of "Drawing" displays the Drawing Options dialog box described above. If "Color Scale..." is selected, the Color Scale dialog box is opened. In this dialog box, the user can set the values represented by the red and blue endpoints of the color bar, the label interval, and the contour interval. Selecting "Vector" opens the Vector dialog box in which the user can select either velocity or flux vectors for display, and set the scale and spacing of the vectors. Selection of "Simulation" opens the Simulation dialog box, within which the user can opt to Save simulation for later replay. "Buffered graphics" is an option that improves the responsiveness of the graphical user interface at the cost of greater memory usage. Users may turn on graphics buffering if their computer has lots of memory (for example, a PC with several hundred megabytes of RAM). You should turn off graphics buffering if your computer has limited memory (for example, a PC with 64 megabytes of RAM).

The user can select which output variable to display (pressure head, moisture content, saturation, concentration or temperature, vector, or none) in the left drop-down list box above the display area. The right drop-down list box allows the user to switch between Cell and Contour displays. When Cell is selected, the display consists of active cells each colored uniformly according to the color scale on the right. When Contour is selected, the display consists of contours with the regions between contours filled with a uniform color according to the color scale on the right.

Display of mass balance errors are included in the postprocessor to give an indication of the accuracy with which the finite difference matrix equations are being solved by the model. Mass balance error alone, however, may not be a valid indicator of simulation accuracy. A small mass balance error may not signify a high degree of accuracy, but a large mass balance error is usually indicative of low accuracy. As an example, backward differencing in the solution of the transport equation is mass conservative and can produce low mass balance errors, but for problems involving sharp concentration fronts, that scheme will not be highly accurate because of the introduction of artificial numerical dispersion.

FILES

Four types of files are used in the VS2DI software package: document files, model input files, model output files, and saved simulation files. The relations between these files and the preprocessor, postprocessor, and numerical model are illustrated in fig. 4 for VS2DTI. Analogous relations apply to VS2DHI. All the files are normally placed in a user-specified directory known as the working directory. Under typical usage, document files are the most visible to the user because they contain the data entered into the preprocessor. By contrast, model input files might be entirely transparent to many users, because these files are automatically generated and require
no handling by the user. Model output files contain simulation results in ASCII format and may be viewed in a text editor, printed, or imported to graphing programs. Saved simulation files contain simulation results that can be displayed in the postprocessor at a later time, after model computations have been performed and the results saved.

Figure 4. -- Relations between files and preprocessor, postprocessor, and numerical model for VS2DTI.

**Document Files**

A document file contains simulation setup data entered into the preprocessor. Document files are saved in binary format and can be opened only in the preprocessor. Note that a document file created by VS2DTI can be opened in VS2DHI. The fluid flow data in this file (for example, initial hydraulic condition) will be recognized by VS2DHI, but users will have to specify energy transport data (for example, initial temperature). Conversely, a file created by VS2DHI can be opened in VS2HTI, but users will have to specify solute transport data.
Model Input Files

Model input files contain ASCII data that are read by the numerical model (VS2DT or VS2DH). For each simulation, there are two model input files. One is known as the **namelist file**, which contains the names of input and output files that are opened by the numerical model. The other is the **model data file**, which contains input data to the numerical model. These files are automatically generated in the working directory and are automatically read by the numerical model when the postprocessor is invoked. This requires no handling by the user. **Therefore, in most cases, users may ignore the model input files.**

The information below is provided for knowledgeable users who want to generate model input files without invoking the postprocessor. This is known as **exporting**. Exporting provides the flexibility for knowledgeable users to manually alter the model data file (using a text editor). Such modification is necessary if the preprocessor is not able to create a model setup in a particular configuration. The modified model data can be run in the postprocessor in standalone mode.

When exporting, the user may assign any name to the namelist file to be generated, although it is recommended that the name terminates with ".fil". In addition, VS2DTI generates the model data file as "vs2dt.dat", while VS2DHI generates "vs2dh.dat". The data format in these model data files is described in Healy (1990) and Healy and Ronan (1996) with the following two exceptions.

A new line of input follows line B-5 and contains two entries. The first entry specifies the "hydraulicFunctionType", which takes on a value of 1 for use of the van Genuchten functions, 2 for Haverkamp, 3 for Brooks-Corey, and 4 for tabular data. The second entry specifies the "adsorptionType", which takes on a value of 1 if a linear isotherm is used, 2 for a Langmuir isotherm, 3 for a Freundlich isotherm, 4 for monovalent-monovalent cation exchange, 5 for monovalent-divalent exchange, 6 for divalent-monovalent exchange, and 7 for divalent-divalent exchange.

The other modification to the model data file is that free format input is now allowed for initial conditions on input lines B-13 and B-25. Because of these modifications, previous versions of VS2DT or VS2DH will not read input files exported from the preprocessor.

Model Output Files

The model output files contain simulation results in ASCII format. These files may be viewed in a text editor, printed, or imported to graphing programs. When a simulation is run, five model output files are generated. The main output file generated by VS2DT is "vs2dt.out." The main output file generated by VS2DH is "vs2dh.out." In addition, both models generate the output files "file07.out", "file08.out", "file09.out", and "file11.out". In the current version of this software, "file07.out" is always empty. The contents of "file08.out", "file09.out", and "file11.out" are identical to those described in Healy (1990).

Saved Simulation Files

A saved simulation file contains simulation results that are saved by the postprocessor. This file is saved in binary format. When running VS2DTI, the simulation results are saved in the file "vs2dt.sim", which is placed in the working directory. When running VS2DHI, the file is
called "vs2dh.sim." However, the user may rename this file. The saved simulation file can be "played back" later by running the postprocessor in standalone mode.

HOW TO OBTAIN AND INSTALL VS2DI

The software described in this report and an electronic version of this manual, along with instructions for downloading and installing the software, can be obtained from the web site:

http://water.usgs.gov/software/

Many other hydrologic computer programs are available at this site. The latest version of VS2DI and a discussion of recent updates will also be available at that site.

Additional copies of this report and the reports by Healy (1990), Healy and Ronan (1996), and Lappala and others (1987) are available from:

U.S. Geological Survey
Branch of Information Services
Box 25286
Denver, CO 80225-0286

For additional information, write to the address on page ii of this report.

REFERENCES CITED